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1. OBIJETIVO
Describir los pasos necesarios para crear y publicar servicios web que permitan acceder a los datos
vectoriales almacenados en diversos repositorios.

2. ALCANCE

Este instructivo se encuentra asociado al procedimiento Disposicidn de Informacién Geogrdfica, el cual
pertenece al subproceso de Gestion Cartogrdfica dentro de la Subdirecciéon de Cartografia y
Geodésica. Inicia con la publicacion de los datos vectoriales vy finaliza con la publicaciéon del servicio.

3. DEFINICIONES

° ArcGIS Pro: Es una aplicacion SIG de escritorio individual, es un software con funciones de
visualizacién de datos geogrdficos, andlisis avanzados y el mantenimiento de datos acreditados en
2D, 3Dy 4D.

° Base de datos espacial: Una base de datos espacial es una coleccién de elementos o datos que
permite modelar, almacenar y consultar datos alfanuméricos o datos espaciales que podrdn ser
procesados por medio de uno o mds softwares especializados. La importancia del manejo de los
datos de este modo es evitar: la redundancia en los datos, el pobre control de los datos y una
inadecuada manipulacién de los datos.

° Cartografia bdsica vectorial: Producto de precisién obtenido a partir de procesos de fotogrametria
analitica o digital, donde se muestran los rasgos naturales y topogrdficos de la superficie terrestre
por medio de simbolos, lineas y poligonos

°  DIVIPOLA: Cdédigo de la division Politico-Administrativa del pais.

° Filegeodatas: Nombre definido para la carpeta de almacenamiento dentro del File Shares de Azure
Storage, alli se localizan las bases de datos vectoriales a publicar.

° Geoservicio: servicio web especifico que devuelve la informacidén geogrdfica situada a los
servidores de los organismos productores, de una forma estdndar y a través de cualquier aplicacion
compatible. Para la generacion y utilizacién de los geoservicios se utilizan los lenguajes y protocolos
estdndares, definidos por el Open Geospatial Consortium (OGC).

° Label: En cartografia, texto colocado en o cerca de una entidad geogrdfica de mapa, el cual la
describe o identifica.

°  Metadato: Datos acerca de los datos geogrdficos. De manera general, son datos que describen,
en una estructura estdndar, el contenido, la calidad y otras caracteristicas de un recurso (productos
y/o servicios), convirtiéndose en un mecanismo clave para localizar, acceder y usar la informacion.

°  Open Geospatial Consortium (OGC): Organizaciéon internacional de membresia que apoya a una
diversa comunidad de empresas, agencias gubernamentales, organizaciones de investigacién y
universidades, todas frabajando juntas para hacer que la informacion sobre localizacién sea FAIR:
Encontrable, Accesible, Interoperable y Reutilizable.

° Sifigacarcgis: Nombre definido para el contenedor File Shares dentro del Azure Storage.

°  Vectorial: Modelo de datos basado en coordenadas que representa las entidades geogrdficas
como puntos, lineas y poligonos. Cada entidad de puntos se representa como un par de
coordenadas simple, mientras que las entidades de linea y de poligonos se representan como listas
ordenadas de vértices. Los atributos se asocian a cada entidad de vector, en contraposicién al
modelo de datos rdster que asocia los atributos a las celdas de la cuadricula.

°  WFS: Hace referencia a Web Feature service Servicio estdndar que ofrece un interfaz de
comunicacion que permite interactuar con los mapas servidos mediante WMS. Presenta
propiedades de edicién, andlisis y descarga.

°  WMS: Hace referencia a Web Map Service, un geoservicio que entrega imdgenes de mapas
georreferenciados a través de internet, el cual puede tener un descriptor de estilo de capa (SLD)
para especificar su simbologia y representacion.
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4. DESARROLLO

El proceso de publicaciéon en los servidores de mapas es llevado a cabo por diferentes dependencias
del Instituto Geogrdafico Agustin Codazzi, a continuacion, se describe el procedimiento para generar la
publicacion.

4.1 PREPARACION DE LA INFORMACION

La informacién que se desea publicar debe estar aimacenada en una base de datos espacial en
formato. gdb, estructurada segun las preferencias o modelos de datos definidos y en el sistema de
referencia MAGNA-SIRGAS / Origen-Nacional.

Se recomienda que se encuentre organizada dentro de carpetas con nombres estandarizados, en
donde adicionalmente se puedan almacenar archivos de descarga y el Metadato. En la ilustracion 1
se observa un ejemplo de organizacién de carpetas y nombres de bases de datos vectoriales de
cartografia escala 1:2.000 del municipio Corrales, Boyacd (DIVIPOLA 15215) con fecha de elaboracion
17/06/2020.

llustracién 1. Eiemplo de organizacion

Nombre

Carto2000_15215_RS_20200617.gdb
Carto2000_Limite_15215_RS_20200617
¢ Carto2000_15215_RS_20200617_gdb
¢ Carto2000_15215_RS_20200617_gpkg
¢ Carto2000_15215_RS_20200617_shp
@ Carto2000_Ficha_Tecnica_15215_RS_20200617

Fuente: IGAC, (2024)

El Instituto cuenta con dos cuentas de Portal for ArcGIS para realizar la publicacién, estas son: mapas
(https://mapas.igac.gov.co/portal) y mapas2 (https://mapas2.igac.gov.co/portal) y con ello dos fipos
de cargue de los datos respectivamente, el primero es en el entorno de la nube mediante el software
Microsoft Azure Storage vy, el segundo en el entforno on-premise desde la NETAPP del Instituto en la
carpeta cemdatos -> Vector -> Cartografia. A continuacién, se describen los dos procedimientos del
cargue.

4.1.1 CARGUE DE LA INFORMACION A MICROSOFT AZURE STORAGE EXPLORER

Si se va a realizar la publicacién en mapas (https://mapas.igac.gov.co/portall, se realiza el cargue de
la base de datos espacial a Microsoft Azure Storage Explorer, el contenedor en donde se sube la
informacion se llama stfigacarcgis y dentro de él en los File Shares se dispone la carpeta frabajoigac,
alli se encuentran cada una de las carpetas definidas para el cargue de informaciéon de acuerdo con
el grupo de trabagjo.

La ilustracién 2 presenta el lugar de almacenamiento en donde se organiza la informacién vectorial.
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llustracién 2. Carpeta trabajo IGAC Azure Storage

EXPLORER o trabgjoigac “m %
x = -
Al 4o + = Rk = | O
Collapse All Refresh All | Upload Download =~ Open  MewFolder SelectAll | Copy Clone | ConnectVM
=i Quick Access
4 P Locl & Attached “ = v 1 current v | trabajoigac
4 = Storage Accounts
Name
» = (Attached Containers) '
3 ulator - Default Ports) (Key) Agrologia
4 = stfigacarcgis (Key) ArcGIS Pro
b [ Blob Containers Backupesri
4 [y File Shares Catastro
B files CIAF
o tabzjeigac Default.gdb
b W Queues FGD2_Publicacion
Tables
P E Filegeodatas
» & Cosmos DB Accounts (Deprecated)
) OptRasters
» |8 Data Lake Storage Gen1 (Preview)
PublicacionCeM
sof

Showing 1to 13 of 13 cached items

Actions Properties ~ Activities

URL https://stfigacarcgis.file corewindows  Clear completed  Clear successfu
Type File Share

Last Modified Tue, 21 Dec 2021 21:05:22 GMT

Quota 3000 GB

Usage 2041 GB

Fuente: IGAC, (2024)

4.1.2 CARGUE DE LA INFORMACION A CEM_DATOS

Si se va a redlizar la publicacién en mapas2 (https://mapas2.igac.gov.co/portal), se debe realizar el
copiado de la base de datos espacial a la carpeta \\172.26.0.20\cemdatos\Vector\Cartografia,
dentro de la subcarpeta respectiva segin la temdtica. Por ejempilo, si se va a publicar un producto de
bases de datos vectoriales de cartografia, deberd aimacenarse en la subcarpeta “Carto”, como se
muestra en la ilustracion 3.

llustracién 3. Carpeta y subcarpetas de cemdatos

& ™ c J > Red > 17226020 > cemdatos > Vector > Cartografia > Carto >
@ Nuevo Tl Ordenar = Ver
% Inicio MNombre Fecha de modificacion Tipo Tamafio
| Galeria Carto1000_05380_20230223.9db 3/07/2024 11:49 a, m. Carpeta de archivos

Carto1000_05021000_20221117.9db 4 6:38 p. m. Carpeta de archivos

> % Daniela, IGAC

Carto1000_05031000_20230226.9db Carpeta de archivos

Carto1000_05036000_20230110.9db Carpeta de archivos

B Escritorio

Carto1000_05040000_20230226.gdb Carpeta de archivos

& Descargas Carto1000_05044000_20230129.gdb 28/05/202411:31 3. m. Carpeta de archivos

Fuente: IGAC, (2024)

4.2 CREACION DEL PROYECTO EN ARCGIS PRO

Se recomienda la creacion de un proyecto en ArcGIS Pro para cada servicio que se desee publicar,
ordenando los proyectos en una carpeta que sea de acceso compartido para los usuarios y que pueda
facilitar la actualizacion de los servicios y el facil acceso a la informacidn origen de estos.
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4.2.1 CREACION DEL PROYECTO EN ARCGIS PRO SI SE PUBLICA DESDE EL PORTAL MAPAS
(https://mapas.igac.gov.co/portal)
Para este caso el proyecto se debe almacenar directamente en las maquinas de produccién de Azure.
Una vez creado, se debe redlizar la conexién a la carpeta de Microsoft Azure Storage Explorer donde
se encuentra la informacidn, en este caso es trabajoigac, siguiendo estos pasos:

a) En el panel Catalog se despliega la pestana Favorites --> Add ltem ---> Add Folder

b) Se copia la ruta de frabajoigac en el buscador
\\stfigacarcgis.file.core.windows.net\trabajoigac, se hace la conexién a la carpeta deseada
para la Direccién de Gestidon de Informacion Geogrdfica la carpeta se denomina Filegeodatas
como se observa en la ilustracion 4.

llustracién 4. Carpeta destinada para la Direccidn de Gestidon de Informacién Geogrdfica

Project  Map  Insert  Analysis  View  Edit  Imagery  Share  Help
- . = . =
o BB 5 aacepriotye | [ My (3 5 b 2
o @ N -o- P y: \ T,EI
0 o ag K @ : == =)
Paste | COP Bxplore K ¥ Bookmarks Go | Basemap Add Select SelectBy Select By Measure Locate Infographics Coordinate
[ CopyPath | | ¥ v Toxv " Datav ~ Attributes Location R + " Conversion
Clipbaara Navig . Labeling sl ommine &l A
Add Folder Connection o X
Contents v A Catalo: v R X
@5 @[E v Computer v trabajoigac v ~ [o][1=] search 2 g
carch B Mz © ! Project Portal Computer Favorites =
, ; - +
= O E.. [p*8 - Name Type Add ftem v
— Agrol Folder
Drawing Order A Folder
4[] Map Backupesri Folder
() Werld Topographic Map Catastro Folder
[w] Werld Hillshade & Deniela Marin Lopez CIAF Folder
" Libraries FGDB_Publicacion Folder
& Network Filegeodatas Folder
Faverites OptRasters Folder
PublicacionCeM Folder
sof Folder
Name | Filegeodatas | [Folders -
ECUADOR
_Guayaqil
1.5/ Amazon Basin (=]
BB 49.3662849°W ATASI60°N v Il |2 [Catal. [Sym. JobS. Label. Locate Geop.. Attr
Fuente: IGAC, (2024)
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c) c) Se conecta al proyecto en donde se deben cargar las capas que se quieren agregar al
mapa. llustracion 5

llustracién 5. Cargue de capas

SR=N7 v v v v Untitled | £ Q daniela.marin - ArcGIS Enterprise Mapas de Colombia 0 L1 - X
Project  Map  Insert  Analysis  View  Edit  Imagery  Share  Help
Cu e M -& iD‘ ) & asdGopricsLayer | 1] QE [ TT 3 Atributes e % |Armeae | &)
Y vera T 1E N =1 ey g ) = @ L ¥)
Paste 5 Copy Explore 7~ ¥ Bookmarks Go | Basemap Add Select SelectBy SelectBy - C'°? Messre Locate Infographics Goordinate. | St Yiew Unplaced oo, | iiond
( copyPath | | = v Toxy v Datav ~ Attributes Location 7' Zoom T v - ~ " Conversion | @ More v - Map~
Clipboard Navigate [ Layer Selection ] Inquiry Labeling 5 ofine & A
Contents v 8 x [Elmep X ~ | Catalog vrx
s =
T [searcn 5] s/ . Project Portal Computer Favorites =
o>2Tald i ortc
I S mie Cartagena " ) Caracas +
5 & F .. |oStamie Cartagena ValerR Addltem v
p— x 5 MapasColombialmagenesAzure.acs
Drawing Order ohanamaCity 1H a
o €} RasterCartografia.sde
4 [F] Map PANAMA s
y ilenendatas
World Topographic Map _Bucaramanga VENEZUELA + Add To Project
Vorld Hillhade f Mesetn 4145 ' Add ToNew Projects Add To Project
[ s = Add a favorite item to the current
L N I A Remoye From Favorites project. The project saves a reference
¥’ B roois to the existing tem.
. Ay New
Y Guian
F(alx}f g > Refresh
y COLOMBIA
(14 B Copy CtrsC
)
& CopyPath Ctri+AltsP
)k
L Quito M Delete Ctrl+D
1 EJl Rename
ECUADOR -
ol Show In File Explorer
4 [E9 View Metadata
{ Amazon Bas / EditMetadata
(113408707 ~|| B B B> o 60.6800559"W 2.1347810° v Il | & | Catal.. [Sym.. JobS.. Label.. Locate Geop.. Attr.

Ay B0 M

12/5/2023

Fuente: IGAC, (2024)

4.2.2 CREACION DEL PROYECTO EN ARCGIS PRO SI SE PUBLICA DESDE EL PORTAL MAPAS2

(https://mapas2.igac.gov.co/portal)

Para este caso el proyecto se debe almacenar en la subcarpeta correspondiente segun la temdtica
como se menciona en el numeral 4.1.2, dentro de la carpeta Proyectos. Por ejemplo, para la creacion
de un proyecto de bases de datos vectoriales de cartografia la ruta seria cemdatos -> Vector ->
Cartografia -> Carto -> Proyectos, como se muestra en la ilustracion 6.

llustracién 6. Carpeta de almacenamiento de proyectos en cemdatos.
& I @] [J > Red > 17226020 > cemdatos > Vector > Cartografia > Carto > Proyectos >

@ MNuevo Tl Ordenar = Ver

~

A Inic MNombre Fecha de modificacian Tipe Tamafio
nicie

Carpeta de archivos

=1

Carto1000_05380_La_Estrella
_"J Galeria - -

Carpeta de archivos

=1

Carto1000_05021000_Alejandria
> @ Daniela, IGAC

=1

Carto1000_05031000_Amalfi Carpeta de archivos

=1

Carto1000_05031000_Interseccion 24/06/2024 1:58 p. m. Carpeta de archivos

=1

B Escritorio Carto1000_03036000_Angelopolis 16/07/20249:14 3. m.  Carpeta de archivos

Fuente: IGAC, (2024)
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De la misma forma que en numeral anterior, se realiza la conexién desde ArcGIS Pro a la carpeta donde
se encuentra la informacién, siguiendo estos pasos:

a. En el panel Catalog se despliega la pestana Favorites --> Add ltem ---> Add Folder
Se copia la ruta de cemdatos en el buscador \\172.26.0.20\cemdatos\Vector\Cartografia y
se hace la conexidn a la carpeta deseada.

4.3 CONFIGURACION DEL PROYECTO EN ARCGIS PRO

La configuraciéon y diseno del mapa depende del objetivo, creatividad y gusto del publicador; se
recomienda el uso de escalas de visualizacién para evitar que el mapa se vea denso vy la informacion
vaya apareciendo por niveles; el uso de labels o etiquetas con fuentes apropiadas para el usuario y
paletas de colores que sean agradables para todo tipo de publico (la pdgina https://colorbrewer2.org/
es una buena fuente para obtener combinaciones de colores para mapas).

Adicionalmente se requiere agregar informacion bdsica de los datos en el metadato (ilustracion 7),
para esto en la tabla de contenido sobre el Mapa se da clic derecho al botdn del mouse para
desplegar las propiedades - metadata.

Se debe verificar en la informacion del Metadato:

° Que el titulo sea explicativo y preferiblemente que siga el esquema de organizacién que se viene
frabajando.

° Diligenciar palabras claves.
° Diligenciar resumen y descripcion.

° Diligenciar en los créditos la enfidad que genera los datos, en caso de ser el IGAC; se recomienda el
uso del siguiente texto: Instituto Geogrdfico Agustin Codazzi — IGAC.

° Adicionalmente se recomienda cambiar el nombre Map en la pestana general por el nombre de los
datos puede ser el mismo titulo que se asignd en el Metadato.

En este punto se reitera la importancia de que los datos se encuentren en con el Ultimo prj del Origen
Nacional denominado “MAGNA-SIRGAS / Origen-Nacional" con EPSG 9377.

llustracién 7. Despliegue del metadato

Fuente: IGAC, (2024)
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Una vez configurada la informacién del metadato, verificado el sistema de referencia de los datos y
definidas las caracteristicas visuales deseadas se realiza la publicacion.

4.4 PUBLICACION DEL SERVICIO

Para la publicacién de cualquier servicio se debe tener usuario de acceso a cada Portal, ya sea mapas
(https://mapas.igac.gov.co/portal/) o mapas2 (hitps://mapas?.igac.gov.co/portal/), en caso de no
contar con el usuario se debe realizar la solicitud a la Direccion de Tecnologias de la Informacién y
Telecomunicaciones mediante incidencia por GLPI.

Es importante aclarar que Unicamente se pueden sobrescribir aquellos servicios generados por su
usuario en caso de que se vaya a publicar un servicio nuevo o Overwrite Web Layer o querer
actualizarlo.

Una vez se tenga el acceso se debe realizar el siguiente proceso:

a. En el menu de ArcGIS Pro se accede a Share ---> Web Layer -> Publish Web Layer

b. Lailustracién 8 muestra la configuracién de la publicacion, si se realizé el diligenciamiento del
metadato la mayoria de la informacidon necesaria se autocompleta. Se recomienda que el
nombre del servicio (campo “Name") sea todo en minUscula sin espacios ni caracteres
especiales. De no ser posible, entonces que siga el esquema de organizacion que han definido.

c. Normalmente, en el item “Data and Layer Type" Unicamente debe quedar activada la opcidn
Map image determinada por defecto, las demds no se deben activar, a menos que se quiera
publicar un Feature service. Es importante recalcar que siempre se debe usar la opcidn
Reference reqgistered data, nunca se deben copiar los datos al servidor.

llustracién 8. configuracion de la publicacién

Contents v 1 x [E] Carto1000.13647000_San_Estanislzo X

~_| Share As Web Layer 2 v R X
T [Scarn o v Sharing Carto1000_13647000_San_Estanislao As..
- & /E.. General Configuration Content
Drawing Order fom Delalle
~ Name
Femmpe]
- N carto1000sanestanislao13647000]
on T .

Summary

La cartografia basica escala 1:1.000 del municipio  ~ |
f San Estanislao (Bolivar), elaborada en el afio 2022
i por el Instituto Geografico Aqustin Codazzi (IGAC), ¥

Tags

Marco_referencia_terres.

7 ) CabeceraMunicipal de
Puente L San:Estanislao de Kostka

) Curva_Nivel

Cartografia_X

San Estanislao X

Bolivar X || Colombia X

Data and Layer Type ©
Via Reference registered data
Limite_Via ® Map Image
Cerca J P~ - [ Feature
Muro ¢ O Vector Tile
Drenaje L

Construccion R Finish Sharing

Zona_Dura

[ analyze [ Spublisn ][ Eobs |

() Drenaje R

ParoSte ARIAR . [118,056 -] BB e 75.1641142°W 10.3919158°N v Il |2 Gat. |Sha.[Sy.. Job.. Lab.. Loc.. Geo.. Attr..

Fuente: IGAC, (2024)

d. En el item Location se deben definir las carpetas de ubicaciéon en el servidor esto con el fin de
conservar el orden en el mismo. Se recomienda que estas carpetas s&e nombren sin espacios ni
caracteres especiales y en minUscula, el campo “Portal Folder” hace referencia a las carpetas
creadas para su usuario y los campos “Server and Folder” al servidor donde se publicard la
informacion y el folder donde se dispondrd, en caso de necesitar una carpeta diferente a las
ya creadas puede agregar una nueva. Para el caso de los servicios vectoriales el Sever
seleccionado siempre corresponde al Hosting Server.

e. Una vez seleccionados los Folder de salida de la informacidén en el item “Share with” se activa
el campo Everyone si quiere compartir el servicio con todo el publico (llustraciéon 9).
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llustracién 9. Activacién Share with

Share As Web Layer 7w R X
Sharing Carto1000_13647000_San_Estanislao As...
General Configuration Content

_) Feature
) Tile

) Map Image
Vector Tile
| Feature €

Location

Portal Folder

‘ carto '|

Server and Folder

‘https:r'e'mapas.igac.gov.(ue’ser\rer (Hosting Servi ‘| G

‘ carto ‘|

Share with
[+] Everyone
[| ArcGIS Enterprise Mapas de Colombia

Groups

Finish Sharing

[ Analye ][ Spublish ][ Eobs |

Fuente: IGAC, (2024)

f. Adicionalmente se deben redlizar las configuraciones de capacidades disponibles, en la

pestana “Configuration” en Configure layer se activa preferiblemente las capacidades WMS y
WEFS. llustracién 10.

lustracién 10. Activacion capacidades

Share As Web Layer v R X
Sharing Carto1000_13647000_San_Estanislao As...

General Configuration Content

B
Layer(s)

E Map Image
Additional Layers
¥ B wwms
[+ 1@ wrg

Capabilities
[ Bwcs

[ Fa kML

Finish Sharing

Fuente: IGAC, (2024)
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g. Luego en la misma pestana de "Configuration” en Configure Pooling seleccione la opcién
“Dedicated Instace” y como instancias minimas coloque el valor 0 y mdximas el valor 2.
llustracion 11.

llustracién 11. Activaciéon de instancias

Share As Web Layer PR X
Sharing Carto1000_13647000_San_Estanislac As...

General Configuration Content

Eln

v Instance Type @

®) Dedicated instance

) Shared instance

v Number of instances per machine €

Minirnum ~
o v
. ~

Fuente: IGAC, (2024)
h. Analizary publicar.

5. CONTROL DE CAMBIOS

FECHA CAMBIO VERSION

° Hace parte del proceso de Gestion de Informacidn Geogrdfica para el SAT, del subproceso de
Gestién Cartogrdfica.

°  Se actudliza el instructivo “Creacién y Publicacion de Servicios Web Geogrdficos - Vectorial”,
cédigo IN-CAR-PC02-02, version 1, a instructivo del mismo nombre, cédigo IN-CAR-PC02-02,

07/10/2024 version 2. . o o 3 N 2

Se encuentra asociado al procedimiento Disposicidon de la Informacion Geogrdfica.

Se gjusta documento a la nueva cadena de valor del IGAC.

Se actualiza plantilla vigencia 2024.

Se actualizan im&genes y enlaces de acceso a repositorios.

Se crea el capitulo de definiciones.

Se adopta como versidn 1 por corresponder a la creacién del documento. Emision Inicial Oficial.

Hace Parte del proceso Gestidon de Informacion Geogrdfica, subproceso Gestion Cartogrdfica.

Se encuentra asociado al procedimiento Disposicidon de la Informacion Geogrdfica. 1

Se crea el instructivo “Creacidn y Publicacién de Servicios Web Geogrdficos - Vectorial”, codigo

IN-CAR-PC02-02, versiodn 1.

o o o o o

20/12/2021

o o o o

. 2 A REVISO 2

ELABORO Y/O ACTUALIZO REVISO TECNICAMENTE METODOLOGICAMENTE APROBO
Nombre: Nombre: Nombre: Nombre:
Elkin Josué Gongora Leal. Victor Andrés Martinez Ruiz. | Karen Andrea Pastrana Pérez. | Carlos Andrés Franco Prieto.
Cargo: Cargo: Cargo: Cargo:
Profesional especializado. Contratista. Contratista. Subdirector.
Direccién de Gestibn de | Direccién De Gestion De | Oficina Asesora de | Subdireccién de Cartografia
Informacion Geogrdfica. Informacion Geogrdfica. Planeacion. y Geodesia.
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Instructivo Creacion y Publicacion de Servicios WEB Geogrdficos - Vectorial

cODIGO VERSION: VIGENTE DESDE:
IN-CAR-PC02-02 2 07/10/2024

REVISO

METODOLOGICAMENTE APROBO

ELABORO Y/O ACTUALIZO REVISO TECNICAMENTE

Nombre:

Yeimy Ledesma Gémez.

[}

Cargo:

Contratista.

Direccién de Gestiéon de
Informacién Geogrdfica .
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